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Sheet G, Gulf of Mexico, Texas      Survey Scale = 1:40,000  C & C Technologies, Inc. 

M/V Moana Wave and R/V Emma McCall 
Hydrographers: Lynn Samuel, Joe Burke          September, 2004 to August 2005 
 
 

A. AREA SURVEYED 
 

The survey area is located at the eastern approaches to Port Aransas, Texas in the Gulf of 

Mexico. The sketch on the following page shows the layout of the Project (OPR-K379-KR) 

and Sheet G (H11245).  Water depths in the survey area range from 32 feet to 114 feet Mean 

Lower Low Water (MLLW). Concur  

 

The survey area was broken down into seven sub-areas to allow for more efficient data 

processing and data management.  The sub-areas were defined based on the predicted data 

set sizes prior to survey commencement.  Subareas 1 and 2 are within tidal zones WGM241, 

WGM242, and WGM228.  Subarea 3 lies within tidal zones WGM242 and WGM228.  

Subareas 4 and 5 are within tidal zone WGM228.  Subareas 6 and 7 lay within tidal zones 

WGM228 and WGM340.  Tidal data from the Corpus Christi, Texas, tide station (8775870) 

was used to process data from all the above-mentioned tidal zones.  A sketch showing the 

layout of the tidal zones and subareas is shown on page 3.   

 

 

1 
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B. DATA ACQUISITION AND PROCESSING      See also the Evaluation Report. 

 B.1 EQUIPMENT 
   

System Manufacturer Model 

Multibeam Sonar Simrad 
EM3000(2004) 
EM3002(2005) 

Side Scan Sonar Klein 5000 
Echotrac (Moana) 3200 Single Beam Sonar Hydrotrac (Emma) OHS 200/9 

Motion Sensor Applanix POS/MVversion 3 
Primary Positioning System Applanix POS/MVversion3 

Secondary Positioning System C-NAV 2000 
Tertiary Positioning System C-NAV 2000 
Sound Speed at Transducer Endeco YSI 

Sound Velocity Profiler Seabird SBE19 
 
 

See the Data Acquisition and Processing Report* for a detailed description of the 

equipment used for hydrographic operations.  The Data Acquisition and 

Processing Report* for project OPR-K379-KR was amended and resubmitted in 

conjunction with the previous survey, Sheet F (H11244), in July of 2005.   

 

The R/V Emma McCall was used as the survey platform for hydrographic 

operations in 2004.  The Emma McCall is 153 feet long and 36 feet wide with an 

approximate draft of 12 feet.  The POS/MV IMU is the vessel reference point.  

The relevant offsets for the POS/MV location are presented in the following table 

where X is positive forward, Y is positive starboard, and Z is positive down. 

* Data filed at the Atlantic Hydrographic Branch (AHB). 

 Port 
EM3000 

Head 

Starboard 
EM3000 

Head 

Side Scan 
Sonar 

Tow Point

Port 
POS/MV 
Antenna 

Starboard 
POS/MV 
Antenna 

X Offset - 0.73 m - 0.58 m -25.76 m 8.47 m 8.47 m 
Y Offset 1.15 m 1.63 m 0.00 m - 2.39 m -0.39 m 
Z Offset 4.43 m 4.43 m -2.95 m -10.78 m -10.78 m 
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The M/V Moana Wave, a 210-foot vessel, was used as the platform for all 

hydrographic operations in 2005.  The vessel is 36 feet wide an approximate draft 

of 13.3 feet.  The location of the POS/MV IMU was the vessel reference point.  

The relevant offsets are presented in the following table where X is positive 

forward, Y is positive starboard, and Z is positive down. 

 

 Port 
EM3000 

Head 

Starboard 
EM3000 

Head 

Side Scan 
Sonar 

Towpoint 

Port 
POS/MV 
Antenna 

Starboard 
POS/MV 
Antenna 

X Offset -0.59 m 0.58 m -40.64 m  1.28 m      1.28 m 
Y Offset -4.89 m 4.92 m -0.80 m -1.002m 1.002 m 
Z Offset 4.42 m 4.43 m -6.14m -7.90 m -7.90 m 

 

Detailed vessel diagrams and patch test results for both vessels are presented in 

the Data Acquisition and Processing Report.* Data filed at AHB. 

 B.2 QUALITY CONTROL 
 

Each subarea’s survey lines were laid out to parallel the long axis of the subarea.  

The line spacing was set at 90 meters based on the criteria of 200 percent side 

scan coverage using Technique 1 as set forth in Section 6.1 of the “Specifications 

and Deliverables” document.  The side scan sonar was operated at a 100 meter per 

channel range except for investigation lines where the range was typically 

reduced to 50 meters.  The angular sector on the multibeam was set so that the 

criterion of two times water depth, as well as all accuracy, resolution, and 

detection criteria as set forth in Sections 5.2 and 5.3 of the “Specifications and 

Deliverables” document, were met. Concur 

 

The internal consistency of the multibeam depth values is quantified in the cross 

line statistics that were performed at the end of each main line. Cross lines were 

run prior to the collection of main line data so that quality control statistics could 
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be performed on the data after each line.  Based on pre-plot calculations, the total 

cross line miles was 148.7 M, while the total main line miles was 2098 M.  The 

cross lines comprised about 7% of the total data set as compared to the main 

scheme lines.  Rerun line miles are not included in these totals.  As can be seen in 

the sample statistics found in Separates V, the main lines and cross lines depth 

values showed very good agreement.  Each main line was compared to all cross 

lines for which there was overlapping data.  The graphs shown in Separates V are 

a random sample of the graphs that were produced.  The graphs show the mean 

difference, RMS difference, and confidence interval for each beam.  The results 

show that the multibeam data was repeatable with 90% of the soundings within 

about 4 to 23 centimeters across the swath. Concur 

 

The following two histograms display the selected soundings for the smooth 

sheet.  The first displays soundings collected with the EM 3000, while the second 

is for the EM 3002.  The chart shows the number of soundings that were selected 

per beam number.  The sounding distribution is dominated by the spatial 

distribution of soundings on the seafloor. The probability of a sounding from a 

particular beam making its way to the smooth sheet is inversely proportional to its 

corresponding density on the seafloor. The sparser soundings near the inner and 

outer edges of the swath are more likely to be selected because there are fewer to 

choose from.  Because only the shoalest of the shoals are selected for the smooth 

sheet, very minor biases in areas of swath data can lead to uneven beam 

distributions.  This can explain why more soundings were chosen from one head 

than from the other. This can also be affected by minor shoal biases in the outer 

beams caused by sound velocity variation in the water column. Concur 

 

The data collected in 2005 using the EM 3002 displays a bias towards the outer 

beams of both transducers.  This is a result of applying shoal biased selection 

criteria over a flat bottom.  As can be seen in the cross line comparison statistics, 
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the data is consistently repeatable, although ray bending is evident in the outer 

beams.  The unconformity of the water body made variations in local sound 

velocity very difficult to account for.  As the survey progressed, the number of 

sound velocity casts taken was increased.  In addition, during collection of Sheet 

H, H11246, which will be submitted later this year, line plans were adjusted to 

further account for this. 

 

Multibeam quality control procedures are outlined in Section B.1 of the Data 

Acquisition and Processing Report. 

 

 
Sheet G (H11245) adjoins with Sheet F (H11244), which was submitted in July of 

2005, and Sheet H (H11246), which will be submitted in the winter of 2006/2007.  

The junction between Sheets F and G was evaluated, and the soundings were 

found to agree to within 1 foot. 

 

Due to shallow water depths in subarea 7, the side scan fish was towed slightly 

lower than the height specified in the specifications and deliverables.  However, 

confidence checks indicated that the side scan was ‘seeing’ out to the full range. 

 

All side scan lines collected during the 2005 field season contain a digital layback 

value.  This value was calculated based on the amount of cable out, the fish height 
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off bottom, and the fish depth.  In some instances, a faulty digital layback value of 

zero was recorded, resulting in layback values of zero.  Lines containing digitally 

recorded zero laybacks appeared to have small gaps when mosaiced, although the 

data is present within the xtf.  All lines containing zero laybacks were mosaiced 

using a manually input layback value. 

 

The following outline describes the steps and parameter settings that should be 

used to convert side scan sonar XTF files, collected by C & C Technologies, into 

a Caris Project. 

 

A.  Define Project: 

1. Go to File > New Project > Add Project. 

Then Add Vessel (Use the vessel file provided for offsets) 

Note:  Offset Values for Sheet G should all be zero. 

Then Add Day 

2. Make any entries you like here 

3. Select Appropriate Projection  

Note:  Projection for Sheet G is WGS 84, UTM Zone 15N 

 4.  Define any limiting Lat/Long or ground units for the Project. 

 

B.  Convert Data Using Conversion Wizard: 

 1.  Select XTF as data format to convert. 

 2.  Navigate to XTF to be converted. 

 3.  Specify what project you will be converting the files to. 

 4.  Define navigation coordinate type as WGS 84, UTM Zone 15N. 
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 5.  Click options as shown below. 

 

 
 

6. Click options as shown below. 
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7. Click options as shown below. 

 

 
 

8. Click options as shown below. 
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9. Click CONVERT. 

 

C.  Open Files: 

 Go to File > Open Project > Select lines to be opened. 

 

D.  Recompute Towfish Navigation: 

1. Select all lines to Recompute Towfish Navigation. 

2. Go to Process > Recompute Towfish Navigation. 

3. Chose SSS Cable Out as the sensor to be smoothed. 

4. Click OK. 

 

E.  Slant Range Correct: 

1. Select all lines to Slant Range Correct. 

2. Go to Process > Slant Range Correction. 
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B.3 CORRECTIONS TO ECHO SOUNDINGS 

No deviations from the Correction to Echo Soundings section in the Data 

Acquisition and Processing Report occurred. Concur 

 

C. VERTICAL AND HORIZONTAL CONTROL 
 

Tide and water level corrections were determined and applied in accordance with Attachment 

#7 of the Statement of Work.    Data from the Corpus Christi, TX (8775870) tidal station was 

used.  Tidal zoning as set forth in the Statement of Work was applied.  The following table 

shows the tidal zone and correctors that were used for this sheet.  Tidal data were processed 

using the 1983-01 epoch. 

 

Tide Zone Reference Station Time Corrector (min) Range Ratio 
WGM228 8775870 +6 1.07 
WGM241 8775870 0 1.01 
WGM242 8775870 0 1.01 
WGM340 8775870 +12 1.10 

 

The horizontal datum for the survey is the North American Datum of 1983 (NAD 83).  The 
projection is Universal Transverse Mercator (UTM) Zone 14 North.  See also the Evaluation 
Report.  The vertical datum for the soundings is Mean Lower Low Water (MLLW).  Concur.  
Approved tides were applied during field processing. 

D. RESULTS AND RECOMMENDATIONS   See also the Evaluation Report.   

 D.1 CHART COMPARISON 

D.1.1 CHARTS AND NOTICES TO MARINERS 

The following charts were used for comparison purposes. 

 
Chart Number Scale Edition Edition Date 
11300 1:460,732 39 April, 2003 
11307 1:80,000 39 March, 2003 
11313 1:80,000 31 February, 2003 
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The Local Notices to Mariners were reviewed from February 2004 through notice 

number 31/05 dated August 2, 2005.  One notice that affects the surveyed area 

was listed in Notice 09/05.  The notice entailed the addition of a platform, and is 

discussed in section D.2.3 (existing infrastructure) of this report. 

 

D.1.2 CHARTED SOUNDINGS 

Chart 11300  

Survey depths throughout the survey area are generally ½ fathom deeper than the 

currently charted survey depths.  Concur 

 

Chart 11307 

Survey depths indicate an area of 1 to 2 feet of shoaling within the safety fairway 

near the eastern edge of the chart area in the vicinity of 27°44’26” N, 096°51’00” 

W.  Depths from this survey range from 78 to 91 feet deep in this area.  Other 

than this area of shoaling, survey depths are in general agreement with charted 

depths.  Concur 

 

Chart 11313 

Survey depths showed general agreement with the currently charted depths, with 

the exception of a 44-foot depth that coincides with a charted 46-foot depth at 

27°54’07” N, 096°55’34” W. Concur  

 

D.1.3 SHOALS AND HAZARDOUS FEATURES 

All charted shoals and hazardous features are addressed in Sections D.1.4 through 

D.1.6. 
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D.1.4 AWOIS ITEMS 

FULL INVESTIGATIONS 

The following seven AWOIS Items were assigned for full investigation.  

  

Item 4154 

Description: Wreck (Calypso Lady) 

Charted Position: 2427°43’01.10”N, 096°44’30.93”W 

Search Radius: 2,000 meters 

Investigation Method: 200% Side Scan Sonar, Multibeam Echosounder 

Position Determined By: Differential GPS 

Investigation Summary: No evidence of this wreck was found within the assigned 

search radius.  It is recommended that this wreck be removed from the chart, and 

the AWOIS listing updated to reflect the results of this survey. Concur  

Delete dangerous sunken wreck PD  

 

Item 4158  

Description: Obstruction (Covered Well) 

Charted Position: 27°44’57.10”N, 096°46’07.93”W 

Search Radius: 1,000 meters 

Investigation Method: 200% Side Scan Sonar, Multibeam Echosounder 

Position Determined By: Differential GPS 

Investigation Summary: According to the AWOIS listing, this obstruction is a 

covered well located near an existing structure.  Additional lines were run 

adjacent to this structure.  Although there were several pieces of debris in the 

area, there was no evidence of a covered well raising above the sea floor.  

According to MMS records, this well was completed.  It is recommended that this 

obstruction be removed from the chart, and the AWOIS listing updated to reflect 

the results of this survey.  
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A significant obstruction appearing to be a pipe standing near vertically was 

found on the north side of the structure within the search radius for this item.  

This obstruction is discussed further in investigation summary G4.  Do not 

concur   Item not shown on chart 11300 41st Ed., Sep/06.  No change in 

charting is recommended.  See item G4. for final charting recommendation. 

 

Item 4185 

Description: Wreck (Liboria C.) 

Charted Position: 27°52’31.08”N, 096°58’30.95”W 

Search Radius: 2,000 meters 

Investigation Method: 200% Side Scan Sonar, Multibeam Echosounder 

Position Determined By: Differential GPS 

Investigation Summary:  No evidence of this wreck was found within the assigned 

search radius.  It is recommended that this item be removed from the chart, and 

the AWOIS listing updated to reflect the results of this survey. Concur. 

Delete Wk PA (23 ft rep) and danger curve (Charts 11307 & 11313)  

     Delete Wk PA (3 ¾ fm rep) and danger curve (Chart 11300) 

 

Item 7909 

Description: Wreck (Capt. Charles Griffin) 

Charted Position: 27°53’01.08”N, 096°46’24.94”W 

Search Radius: 2,000 meters 

Investigation Method: 200% Side Scan Sonar, Multibeam Echosounder 

Position Determined By: Differential GPS 

Investigation Summary:  A small contact was found within the assigned search 

radius, and was further investigated as item G2.  After investigation, the item was 

deemed insignificant.  It is recommended that this wreck be removed from the 

chart, and the AWOIS listing be updated to reflect the results of this survey.      

Concur. Delete dangerous sunken wreck, PA.  
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Item 11898   

Description: Obstruction (Unknown) 

Charted Position: 27°51’09.00”N, 096°41’39.60”W 

Search Radius: 2,000 meters 

Investigation Method: 200% Side Scan Sonar, Multibeam Echosounder 

Position Determined By: Differential GPS 

Investigation Summary:  This item is listed as a dangerous sunken helicopter.  

During survey operations in 2004, a small contact over one meter in height off the 

bottom was seen in the southwestern corner of the assigned search radius.  This 

contact was investigated further in 2005 as investigation item G1.  The contact 

was no longer present in this location.  It is recommended that this item be 

removed from the chart, and the AWOIS listing updated to reflect the results of 

this survey. Concur      Delete dangerous sunken wreck, PA.  

 

Item 11900

Description: Wreck (Kentucky Daughter) 

Charted Position: 27°46’30.00”N, 096°47’00.00”W 

Search Radius: 2,000 meters 

Investigation Method: 200% Side Scan Sonar, Multibeam Echosounder 

Position Determined By: Differential GPS 

Investigation Summary: No evidence of this wreck was found within the assigned 

search radius.  It is recommended that this item be removed from the chart, and 

the AWOIS listing updated to reflect the results of this survey. Concur  

Delete dangerous sunken wreck, PA 

 

Item 11901  

Description: Obstruction (Unknown) 

Charted Position: 27°45’37.80”N, 096°47’22.20”W 
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Search Radius: 2,000 meters 

Investigation Method: 200% Side Scan Sonar, Multibeam Echosounder 

Position Determined By: Differential GPS 

Investigation Summary: No evidence of this obstruction was found within the 

assigned search radius.  It is recommended that this item be removed from the 

chart and that the AWOIS listing be updated to reflect the results of this survey. 

Delete dangerous sunken wreck PA 

 

ASSIGNED OR UNDETERMINED 

Eight AWOIS Items were listed as information only search types.  Of these eight 

items, one was listed as assigned, five were listed as undetermined, one was listed 

as completed, and one as unassigned.   

 

Assigned 

AWOIS item 4186, the wreck Margie B, was assigned for information only.  A 

portion of the search radius of AWOIS item 4186 was covered during the survey.  

No evidence of this wreck was seen in the very limited portion of the search 

radius covered by this survey.  It is recommended that this wreck remain as 

charted. Concur 

    

Undetermined 

AWOIS items 201, 208, 4152, 4160, and 4191 lie completely outside of the 

survey area and no portion of their search radii were covered during the survey. 

 Concur 

 

Completed 

AWOIS item 8877 was listed as completed, but lies complete outside of the 

survey area and no portion of its search radii was covered during the survey.   

Concur 
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Unassigned 

AWOIS item 11899 lies completely outside of the survey area and no portion of 

its search radii was covered during the survey. Concur 

 

D.1.5 INVESTIGATION ITEMS 

Additional investigation work was performed for five sonar contacts.  A set of six 

to eight additional multibeam and side scan lines were run over each of these 

targets. 

 

Item G1 

Description AWOIS item 11898 
Investigation Method 100% multibeam and 400% side scan 

Original Survey 250/020725S (ss122) 
250/022247S (ss123) Sonar 

Contacts Investigation None 
Least Depth N/A 

Charting Recommendation 

During survey operations in 2004, a small 
contact was seen in the side scan record 
within this AWOIS items search radius.  
Further investigation of this item took place 
during survey operations in 2005, at which 
time the contact was not present.  No 
evidence of this AWOIS item was found.  It 
is recommended that the chart be updated to 
reflect the results of this survey. 

Concur          See AWOIS #11898 for final charting recommendation. 
 

Item G2 

Description AWOIS item 7909 
Investigation Method 100% multibeam and 400% side scan 

Original Survey 250/172540S (ss145) 
250/174147S (ss146) 

Sonar 
Contacts Investigation 

214/123419P (INV300) 
214/125125P  (INV301) 
214/131153S (INV302) 
214/134722S  (INV304) 
214/140334S (INV305) 
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Least Depth 21.71 meters (71 feet) 

Charting Recommendation 

During pregrid survey operations, a small 
contact was seen within the search radius for 
this AWOIS item.  After further 
investigation, this item was deemed to be 
insignificant.  It is recommended that the 
chart be updated to reflect the results of the 
current survey.  

Concur          See AWOIS #7909 for final charting recommendation. 
Item G3 

Description Possible wreck 
Investigation Method 100% multibeam and 400% side scan 

Original Survey 250/192523S (ss149) Sonar 
Contacts Investigation None 
Least Depth N/A 

Charting Recommendation 
An object that appeared to potentially be a 
wreck was seen during the survey.  After 
further investigation, no contact was seen.   

Concur      No change in charting is recommended. 

 

Item G4 

Description Vertical Pipe 
Investigation Method 100% multibeam and 400% side scan 

Original Survey 
204/212954P (612) 
204/221948S (613) 
264/214943P (SS328) Sonar 

Contacts 
Investigation 214/194742S (INV507) 

214/200414P (INV508) 
Least Depth 27.2 27.864 meters (89 91 feet) approximate
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Charting Recommendation 

This obstruction is located within the search 
radius of AWOIS item 4158.  During survey 
operations, a significant contact resembling a 
pipe standing vertically on the bottom was 
noted on the north side of an existing 
structure, MI 754A. 
 
Attempts to locate the pipe during multibeam 
investigation were unsuccessful due to its 
narrow profile and proximity to the structure.  
It is recommended that an 89 foot obstruction 
be charted as Obstn (rep 2005) at 
27°45’00.29”N, 96°46’08.75”W.  The 
position and depth of this obstruction were 
calculated from side scan investigation line 
INV508.  

    Concur w/ Clarification.  Ensonification data of pipe feature was available   in     
bathymetry.  Chart non-dangerous obstruction, least depth 27.864 meters (91 ft , 
and 151/16 fathom)  at Latitude  27°44’59.83”N, Longitude 96°46’08.44”W.  Survey 
Line: H11245 / Moana Wave / 2005-214 / 242-inv500, Profile/Beam: 2890 / 34)  
Chart Obstruction with a depth of 15 fms (15 Obstn) in present survey location.  
Chart 15 fms Obstn. 

 
Item G5 

Description Rectangular piece of debris 
Investigation Method 100% multibeam and 400% side scan 

Original Survey 175/084601P (482) 

Sonar 
Contacts Investigation 

214/221956P (INV600) 
214/213427S (INV601) 
214/214505S (INV602) 
214/220250P (INV603) 

Least Depth 26.67 meters (87 feet) 

Charting Recommendation 

After investigating this item, it was deemed 
to be insignificant debris.  It is recommended 
that the chart be updated to reflect the results 
of the current survey. 

 

D.1.6 DANGER TO NAVIGATION REPORTS 

No Danger to Navigation Reports were issued.  
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 D.2 ADDITIONAL RESULTS 

D.2.1 PRIOR SURVEYS 

Comparison with prior surveys was not required under this Task Order.  See 

Section D.1 for comparison to nautical charts. 

D.2.2 AIDS TO NAVIGATION  

There were no Aids to Navigation present in the survey area at the completion of 

the fieldwork in August 2005.   

D.2.3 EXISTING INFRASTUCTURE 

The following platforms were found as charted. *Concur 

Survey Position Description Latitude Longitude 
*MI696 27°53’10.62”N 96°44’39.56”W 

*MI721_1 27°52’01.59”N 96°57’33.60”W 
*MI754A 27°44’58.27”N 96°46’08.08”W 
*MI844 27°53’11.42”N 96°59’00.39”W 

 

Local Notice to Mariners number 09/05 listed the addition of a platform, MI 839, 

at the following location.  This platform was found as listed in this notice. Concur 

 

LNM 09/05 Position 
Latitude Longitude 

27°53’15.90”N 96°58’21.00”W
 

One previously uncharted platform, MI 721_L, was present at the time of 

completion of the survey.  It is located at the following position. Concur 

 

Survey Position 
Latitude Longitude 

27°52’46.59”N 96°57’19.08”W
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Two Platforms charted at the following locations were not present at the time of 

survey. 

Charted Position 
Latitude Longitude 

27°51’49”N 96°58’43”W* 
27°52’11”N 96°58’28”W

27°52’11.47”N 96°58’38.53”W*

*Defer to Marine Chart Division, Nautical Data Branch. 

D.2.4 OTHER PERTINENT INFORMATION 

As noted earlier in section B.2, quality control, a number of side scan lines 

contain a digitally calculated layback value of zero.  At first, the gaps caused in 

the coverage mosaic were thought to be a result of navigation jumps.  As a result, 

all of these gaps were rerun.  These short rerun lines are included in the logs and 

deliverables, but are not included in the final coverage mosaic or the side scan 

correlation sheet.  The gaps in the mosaic were filled by applying a manual 

layback value to the original xtf.  Below is a list of these rerun lines and the 

original xtf they are associated with. 

 

Original 
xtf Manuel layback value applied Rerun 

527 44.8m 629, 638
529 44.8m 631 
502 45.5m 630 
531 46.9m 636 
538 46.9m 628 
540 46.9m 634 
498 47.4m 622 
553 45.2m 626 
496 47.7m 633 
520 45.9m 624 
522 46.4m 625 
524 45.8m 623 
550 47.4m 627 
526 45.3m 632 
551 45.8m 637 
541 46.8m 620 
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ATLANTIC HYDROGRAPHIC BRANCH 
EVALUATION REPORT FOR H11245 (2004-2005) 

 
 This Evaluation Report has been written to supplement 
and/or clarify the original Homeland Security Project Report. 
Sections in this report refer to the corresponding sections of 
the Project Report. 
 
B. DATA ACQUISITION AND PROCESSING
 
 The following software was used to process data at the 
Atlantic Hydrographic Branch:  
 

CARIS HIPS/SIPS version 5.4 
MapInfo, version 6.5 
MicroStation J, version 07.01.04.16 

  I/RAS B, version 07.01.000.18   
Pydro v6.8.0 

 
The Preliminary Smooth Sheet was plotted by the contractor. 

No revisions were made to the Preliminary Smooth Sheet (DGN) 
during office processing.  The preliminary smooth sheet was 
plotted using a Hewlett Packard DesignJet 2500CP plotter during 
office processing. 
 
C. VERTICAL AND HORIZONTAL CONTROL 
 

HORIZONTAL CONTROL  
 
Horizontal control used for this survey during data acquisition 
is based upon the North American Datum of 1983 (NAD 83). Office 
processing of this survey is based on these values. 
 
 JUNCTIONS
 
    Standard junctions were not performed between surveys H11246 
(2004) to the south and H11244 (2005) to the northeast.  These 
surveys have already been submitted to MCD. The junctions will 
have to be completed at MCD during compilation. Present survey 
depths are in harmony with the charted hydrography to the 
northwest, east, or west. 
 
 
 
 
 
 



                        
           

D. RESULTS AND RECOMMENDATIONS
 
COMPARISON WITH CHART 11313, 21st, Edition, Feb./03  

       11307, 36th, Edition, Mar./03
11300, 39th, Edition, Sep./06 

 
The charted hydrography originates with the prior surveys 

and requires no further consideration.  The hydrographer makes 
adequate chart comparisons in Section D. of the Descriptive 
Report. The following should be noted: 

 
A charted Obstn, PA (cleared 90 ft) in Latitude 27°42’30”N, 

Longitude 96°51’45”W was neither verified nor disproved by the 
present survey.  No change in charting is recommended. 
 

The present survey is adequate to supersede the charted 
hydrography within the common area. 
   

COMPARISON WITH PRIOR SURVEYS 
 
     A comparison with prior surveys was not done during office 
processing in accordance with section 4. of the memorandum 
titled Changes to Hydrographic Survey Processing, dated May 24, 
1995.   
 
  The present survey is adequate to supersede the prior 
surveys in the common area. 
 
 MISCELLANEOUS 
 

Chart compilation using the present survey data was done by 
Atlantic Hydrographic Branch personnel in Norfolk, Virginia. 
Compilation data will be forwarded to Marine Chart Division, 
Silver Spring, Maryland.   

 
The following NOS charts were used for compilation of the 

present survey: 
 

 11300 (41st edition, Sept./06) 
 11307 (37th edition, Jul./06) 
 11313 (23rd edition, Oct./05) 
 

ADEQUACY OF SURVEY
 
This is an adequate multibeam, side scan sonar survey. No 

additional field work is recommended.  



                        
           

 
 
__________________________                                                 
Reginald L. Keene Sr. 
Cartographer 
Verification of Field Data 
Evaluation and Analysis 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 

APPROVAL SHEET 
 H11245 
 
 

The completed survey has been inspected with regard to 
survey coverage, development of critical depths, cartographic 
symbolization, and verification or disproval of charted data.  
The survey records and digital data comply with NOS requirements 
except where noted in the Evaluation Report.  
 
 
 

                                       Date:              
Norris A. Wike 

     Cartographer 
     Atlantic Hydrographic Branch 
 
 

 
 
     I have reviewed the accompanying data and reports.  This 
survey and accompanying digital data meet or exceed NOS 
requirements and standards for products in support of nautical 
charting except where noted in the Evaluation Report. 
 
 
 
Approved:                                  Date:              

      Shep Smith 
           Lt. Commander, NOAA 

      Chief, Atlantic Hydrographic Branch 
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